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Related Manuals

To ensure system safety, always read and follow the information provided in all Safety
Precautions and Precautions for Safe Use in the manuals for each device that is used in the

system.

The following shows the manuals for OMRON Corporation (hereafter referred to as OMRON)
and Delta Tau Data Systems, Inc (DT).

Manufacturer | Manual No. Model Manual name

OMRON 1610-E1 Model CK3E-OIO1OO Programmable Multi-Axis Controller
Hardware User’s Manual

OMRON W580-E1 Model NY510]-ACICIC] Industrial PC Platform NY-series
IPC Programmable Multi-Axis
Controller Hardware User’s Manual

OMRON 1586-E1 Model R88M-1LL1/-1M[] R88M-1[11, R88D-1SNLI-ECT

Model R88D-1SNLI-ECT Built-in EtherCAT® Communications

User’s Manual

DT 0014-E - Power PMAC User’s Manual

DT 0015-E - Power PMAC Software Reference
Manual

DT 0016-E - Power PMAC IDE Users Manual




2. Terms and Definitions

Term Explanation and Definition
Slave Slaves are devices connected to EtherCAT. There are various types of
slaves such as servo drivers handling position data and 1/O terminals
handling the bit signals.
Object Represents information such as in-slave data and parameters.
PDO One type of EtherCAT communications in which Process Data Objects

communications
(Communications
using Process Data
Objects)

(PDOs) are used to exchange information cyclically and in real time.
This is also called “process data communications”.

PDO Mapping The association of objects used for PDO communications.

PDO Entry PDO entries are the pointers to individual objects used for PDO
mapping.

ESI file An ESI file contains information unique to the EtherCAT slaves in XML

(EtherCAT Slave format.

Information file)

You can load ESI files into the EC-Engineer, to easily allocate slave
process data and make other settings.

ENI file
(EtherCAT Network
Information file)

An ENI file contains the network configuration information related to
EtherCAT slaves.

Power PMAC IDE

This computer software is used to configure the Controller, create user
programs, and monitor the programs.
PMAC is an acronym for Programmable Multi-Axis Controller.

Acontis
EC-Engineer

This computer software is used to configure the EtherCAT network and
each slave.




3. Precautions

(1) Understand the specifications of devices that are used in the system. Allow some margin
for ratings and performance. Provide safety measures, such as for installing a safety
circuit, in order to ensure safety and minimize the risk of abnormal occurrences.

(2) To ensure system safety, always read and follow the information provided in all Safety
Precautions and Precautions for Safe Use in the manuals for each device that is used in
the system.

(3) The user is encouraged to confirm the standards and regulations that the system must
conform to.

(4) Itis prohibited to copy, reproduce, or distribute all or part of this document without the
permission of OMRON Corporation.

(5) The information contained in this document is current as of July 2016.

It is subject to change without prior notice for improvement purposes.

The following notations are used in this document.

Indicates a potentially hazardous situation which, if not avoided,
may result in minor or moderate injury, or may result in serious

/A WARNING

injury or death. Additionally, there may be severe property
damage.

f C t. Indicates a potentially hazardous situation which, if not avoided,
aution may result in minor or moderate injury, or property damage.

IE' Precautions for Correct Use

Precautions on what to do and what not to do to ensure correct operation and performance.

@ Additional Information

Additional information to read as required.
This information is provided to increase understanding or make operations easier.

Symbols

The filled circle symbol indicates operations that you must carry out.

The specific operation is shown in the circle and explained in text.

This example indicates a “general precaution” for something that you must
carry out.




Overview

This document describes the procedures used to operate the OMRON servo drivers
(1S-series EtherCAT communication built-in type, hereafter referred to as Servo Driver) using
the motion program for OMROM Programmable Multi-Axis Controller (hereafter referred to as
the Controller), model CK3E-LIUOL/NY510-ALOIL, as well as for checking the operation.
In the document, Servo Driver and servomotors to be connected are collectively called motion
control devices. Servo Driver may also be referred to as a slave depending on the
explanation.

Refer to Section 6. EtherCAT Connection Procedure to learn about the setting methods and
key points to perform PDO communications via EtherCAT. In this document, the motion
program is used to check operations.

The range of usage of this document is checking the connection of motion
control devices connected via EtherCAT. When using instructions and
constructing systems that are not described in this document, always read and
follow the information provided in all Safety Precautions and Precautions for
Safe Use in the manuals for each device that is used in the system.




5. Applicable Devices and Device Configuration

I 5.1. Applicable Devices
The applicable devices are as follows:

Manufacturer Name Model
OMRON Programmable Multi-Axis Controller | Model CK3E-LILIOL
OMRON Programmable Multi-Axis Controller | Model NY51[1-ACICIC]

Industrial Box PC
OMRON Servo Driver Model R88D-1SNLI-ECT

IE' Precautions for Correct Use

In this document, the devices with models and versions listed in Section 5.2 are used as
examples of applicable devices to describe the procedures to connect the devices and check
their connections.

You cannot use devices with versions lower than the versions listed in Section 5.2.

To use the devices mentioned above with models not listed in Section 5.2 or versions higher
than those listed in Section 5.2, check the differences in the specifications by referring to the
manuals before operating the devices.

@ Additional Information
This document describes the procedures to establish the network connections. It does not
provide information on operations, installations, wiring methods, device functionalities, or
device operations, which are not related to the connection procedures. For more information,
refer to the manuals or contact your OMRON representative.



I 5.2. Device Configuration

The hardware components to reproduce the connection procedures in this document are as

follows:

Windows computer
Power PMAC IDE
Acontis EC-Engineer

Model CK3E-LIOOO

Model R88D-1SNO2L-ECT

Ethernet EtherCAT
communications communications
Manufacturer Name Model Version
OMRON Programmable Multi-Axis Model CK3E-1UJ0] Ver.2.2
Controller
Servo Driver (1S-series with Ver.1.0
OMRON Built-in EtherCAT Model R88D-1SNO2L-ECT
Communications)
OMRON Ethernet cable (with industrial Model
Ethernet connector) XS5W-T421-LIMLI-K
- Windows computer -
DT Power PMAC IDE setup tool Power PMAC IDE Ver.2.2
Acontis EtherCAT master setup tool Acontis EC-Engineer Ver.2.4.3

IE' Precautions for Correct Use

Prepare the ESI file described in this section in advance. Contact your OMRON
representative for information on how to procure the ESI file.

IE' Precautions for Correct Use

Do not share the connection line of EtherCAT communications with other Ethernet networks.
Do not use devices for Ethernet such as a switching hub.

Use the Ethernet cable (double shielding with aluminum tape and braiding) of Category 5 or

higher, and use the shielded connector of Category 5 or higher.
Connect the cable shield to the connector hood at both ends of the cable.

Additional

This document describes model CK3E-LILILIL] as an example. The same procedures can

Information

apply to model NY510J-ACICIO].

©



6. EtherCAT Connection Procedure

This section describes the procedures to connect the Controller and Servo Driver via
EtherCAT, and to operate the motion control devices. The description assumes that the

Controller is set to factory default.

/A WARNING

resulting in a personal injury to the user.

via Ethernet cable.

If an uninitialized Controller is used, the motion control devices may perform
unexpected operations upon power-on depending on the Controller status,

To prevent unexpected operations of motion control devices, be sure to initialize
the Controller before connecting the motion control devices and the Controller

I 6.1. Workflow

Take the following steps to operate the motion control devices after connecting the Controller

and Servo Driver via EtherCAT.

6.2 Preparation for the Controller Setup

v
6.2.1 Creation of a New Project
v
6.2.2 Initial
v
6.3 Installation of ESI Files
v
6.4 EtherCAT Communications Setup
v
6.4.1 Communications Setup for the EtherCAT Master
v

6.4.2 Distributed Clock Setup

6.4.3 PDO Map Settings

v
6.4.4 Creation of an EtherCAT Network Configuration
File
v
6.5 Controller Settings
v

10

Prepare the Controller settings.

Install the ESI file for Servo Driver
into Acontis EC-Engineer.

Set up EtherCAT communications.

Set up the Controller.



6.5.1 EtherCAT Network Configuration Settings

6.5.2 EtherCAT Communications Check

v
6.5.3 Motor Setup
v
6.5.4 EtherCAT Variables Settings
v
6.5.5 Creation of Operation Check Programs
v

6.5.6 Project Data Transfer and Operation Check

11



I 6.2. Preparation for the Controller Setup

Prepare the Controller settings.
Install Power PMAC IDE and Acontis EC-Engineer on the computer in advance.

6.2.1. Creation of a New Project

1 Connect the Controller to the
computer via Ethernet.

2 Turn on the power to the
Controller.

3 Start Power PMAC IDE.

* |f the dialog for confirming
access rights appears upon
start-up, select starting of Power
PMAC IDE.

4 The Communication screen

appears. Specify the IP address | & Delta Tau Data Systems Inc. Emrimnmen' |
— —————————__ =
of the destination Controller and Communication | I
|

click Connect. @=: 4| | =
I IPAddress 192.168.0.200 (=]
Part »
*
The IP address of the Protocol SSH
Controller is set to User root
. ., Pazzward 259988899
192.168.0.200" by default. Apply AllGantrals True
SelectDevice &tStartup True

* |f necessary, change the
Windows IP address to

“192.168.0.X". IP Address
Set IP Address

Connect

[ Lazt Ses=ion ] ’ Mo Device ]

For detailed setup options go to Tools menu -> Options
-> PowerPMAC

12



5 Power PMAC IDE starts, and is
online to the Controller.

© Power PMAC Sus (EPRE)

Ele £t View Project Puld Debug Tocls Defts Ty Window  Help
A ARIER= " N IR W RN

Ll 5| b Debug + Any CBU LAY 2
tus i Jog Ribben | o Communication Setup

Watch: Online]192.168.0.200:55H] » 0 X

o 2
Send P Command

ac{Mo Device:)

& [ Doturmentation
® g
@ (23 PMAC Script Language

L2 = == !
- |FarEy ~IX
&5 ¥ K| powerPmac(No Device:) Project Proper +
wARCERSG): Bt =la et im | YRE=)
| User Buffer 1 =
{B PowerPMAC Communicution Setup
Device Properties x|
sy
- || communication Settings

 FOzz 4 Poweremac GERCEALELR.

6 From the File menu, select New
then Project.

=
% Power PMAC Suite (Administrator)

Delta Tau

Edit View Tools

Mew »

Window Help

Ctrl+Shift+N U
CErl+N

51 Project...
Open L |

Close

File...

Project From Existing Code...

] | Close Solution

Save Selected Items  CErl+5S

Save Selected Items As...
Save All Ctrl+Shift+5

Export Template...

@ | Page Setup...

Ctrl+P

| & | Print...

H Recent Files »

| Recent Projects »

Exit

7 Enter a project name, and select

OK.

2
nE

[Fomees PRiAL
ey [Craccsen

Londion: .-
Fokiion bage: | [CTAi3ei0 F treate drectony b adhutan

o LA
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6.

2.2. Initial Settings of the Controller
Configure the initial settings for the Controller.

IE' Precautions for Correct Use

Configuring the initial settings clears all data in the Controller memory. Back up necessary

data in advance.

In the Terminal pane, type the
$$$*** command to reset the
Controller to factory default.

- Power PMAC Suite

File Edit Yiew Project Build Debug Tools DeltaTau Window Help

- =N~ - - -  Debug -

Woatch: Online[192.168.0.200:55H] + I X || Position: Onli

On
Send Dernand Command Response

TUUW Smsemetn s |
[C] ECATIOLEnable 1
E Slave_0_B071_0_Targettorque |stdin:3:2: err... | -

Terminal: Online[192 168.0.200:55H] > I X pp_disable.

I %%k
&%L

disab
clear

enabl

555+ 4

2 From the Tools menu, select
System Setup to start System
Setup.

S Powper PMAL Sute (Admmistrator]

Fla Bt Vew Debug |Tood | DeltaTau  Windsw  Halg
& - el o
.:Turmd _:‘I-_F':rsha'. E .. Fiat

Wik D[R90 100, 0200 MY

On | B TaskMansger
Sond| 4 | Comm

|

23

r r:-:.m:f e [
- EcaT| W | Aktach to Process Chisalt+p
M |Ecamm SRR

External Tooks..

Qe .,

[ e

To Cruree i PAM Fomrcy Of e e Accrvr St St o
i o
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3 From the File menu of
PowerPMAC System Setup,
select New then Setup.

PowerPMAC System Setup : Online[192.168.0.200:55H]

File | Database

| New v Setup I
Add r
Save Setup
Restore Setup

4 Specify Servo Frequency.

Select the Servo Frequency
setting from 4 kHz, 2 kHz, or
1 kHz.

Global Clock Setting

Phase Frequency 1.000 kHz

Servo Fraquency (1000 = kHz

Detected Servo Hardveara-F%M Freguency

5 Click the Accept button.

o 0 P

Q

i el
Mew clock  PowerPMAC w’: |

settings Wale
Servo Perod (maec) 1000 1000
FhaseChverServoPeriod 1000 1000

Items

Mo Master Gate detacted and No

ETHERCAT opticn detected

PowerPMAC can be used as a PCusing |_
@ software clock. (sys CPUTimerlntr = 1) On|

Accepting the clock issue save and 555

in the terminal window for changes to

take effect Check 'sys. ServoTime” to

6 If you have changed the servo
frequency setting, type the save
command in the Terminal pane
of Power PMAC IDE.

When complete, the “Save
Complete” message appears in
the Terminal pane.

Terminal: Online[192.168.0.200:55H] » 1 X

Save Complete

ave

15



7 Click Communication Setup on the
toolbar to display the Device | Fic et view Doy Took DotaTr Wmdow Mo
. . Fril-Bda <A | £
Properties dialog box. ;. i gt et M :
| Watch: cffine >0 X = -1
] g:muml i + ._i Dvice: Properties
W 5y SencCount [ IR
Terminal: Gifline e = [D:Diln
IT‘P«I:ich;s !l:nDevice
Pl SSH
E.';gr . rBo‘t _____ -
|
E%]
\‘ WHROERS): -
8 In the Device Properties dialog box,
. B Device Properties &J
select No Device for IP Address, then "’- T ]
. Test Apply
click the Apply button. |
22l
O Device -
R . IPAddress No Device F
This operation sets the Controller to Prthimber H
. Protacal 55H =
the offline state. Do oot v
IP Address
Set IP Address
o] The Controller restarts.
The servo frequency that has been
set is reflected.
10 Wait until the startup process of the i ]
. . B Device Properties | ﬁ
Controller is complete. Then click
. . Test Apply
Communication Setup on the BN [N L
toolbar to display the Device A
. . =
Properties dialog box. ‘
. . . || Protocol S5H —
In the Device Properties dialog box, Yeer L S Z
IP Address

return the IP Address to the previous
setting, then click the Apply button.

This operation sets the Controller to
the online state.

Set P Address

16



I 6.3. Installation of ESI Files
Install the ESI file for Servo Driver into Acontis EC-Engineer.

M Precautions for Correct Use

Prepare the ESI file described in this section in advance. Contact your OMRON
representative for information on how to procure the ESI file.

1 Start EC-Engineer.

£ Power PMAC IDE 8

Y

-_‘_.| Windows Explorer ¥

‘ #‘ EC-Engineer 3

,’.1,.1ﬁ Paint v
Rl 4

»  AllPrograms

|Search programs and files

17



2 From the File menu of
EC-Engineer, select ESI
Manager.

The ESI Manager appears.

= EC-Engineer [--]

m View Network Settings Help

2 New Ctri+N

= Open Ctri+0

KH save Ctrl+5 _
K save As

| | g Add Mastar-Unit b

I- ESI Manager

Bl Liocaior

= Recent Projects 3

Exit Alt+F4

Example of the ESI Manager

= ESI Manager

el

ESI Files

Select an ESI file which should be deleted or exparted or add new ESI files.
» 0 Baumueller Nuemberg GmbH
EEck

Wore  Beckhoff Automation GmbH & Co. KG

@ Copley Controls Corp.

Z= Omren Corporation

3

>

b L Lenze
>

¥ uph VIPA GmbH
>

% askawa Electric Corporation

Number of ESI files: 97
Number of devices: 2213

Add File Add Folder Close
3 Confirm that Omron _ E—
R88D-1SN02L-ECT-XmI is Ei:t;:nEsl.ﬂkmchymdmmD‘O-M&UMWESINH .
registered in the ESl file list of ESI
Manager.
If it is not yet registered, click Add
File and register Omron Paptm A

R88D-1SNO2L-ECT.xml.

Add Fle A Fokder Close

ek e
@D',_- # Docum.. » Ormvon RES0-1SHe ECT

Grgunize »  Boon foder

£ Freaes
M Debtop
B Dowelcsss -]
L Recwt Blace. |

S Documents library

= Omron RBS0-1SHOTH-ICT

B = Omion RBAD-15HOLLAECT
¥ Bocumene: = =

& e l O RESD-LSHNIL-EC T '
el Pt i Cmeos o

H videss +! Cron REBD-LSHML-ECT

= Oy RESD-1SHOBF-ECT

W Crmmeter

Pt g ez PEED1SHOOLECT v | F

fril Cancel

4 Click Close to close the ESI
Manager page.

18



I 6.4. EtherCAT Communications Setup
Set up EtherCAT communications.

/\ WARNING

Depending on the Controller status, unexpected operations of the motion
control devices may occur when the power to the Controller is turned on,
resulting in a personal injury to the user.

Pay attention to safety when the power is turned on.

IE' Precautions for Correct Use

Before taking the following steps, make sure that the devices are connected via an Ethernet
cable. If they are not connected, turn OFF the power to the devices, and connect the Ethernet
cable.

6.4.1. Communications Setup for the EtherCAT Master

1 Connect the Controller with
slave devices using an Ethernet
cable.

* Refer to the manuals for slave
devices to configure them.

2 Display Start Page of

EC-Engineer, and select [ — —
EtherCAT Master Unit (Class i ———
A) from Add Master Unit. EC «Engineer

3 Class-A Master is added to the

Project Explorer. = EC-Engineer [--]
File  View Network Settings Help

£ Configuration Mode B Diagnosis Made

Proiart Fynlnrar Device Editor
 Class-A Master Master

19



In the Master page, specify a
communication period for Cycle
Time [us].

* You must specify the
communication period in
accordance with the servo
frequency of the Controller.
1000 us is set in this document.

Master

General

anit Mam, PRI
I Cycle Time [us] 1000 I

Source MAC address

Slaves connected to local system
Fetwork Adaptes D—7JL TUPEE | Intel(R) Ethernet Connection 1217.LM )

Salect
Slaves connected to remote system
IP Address 192 .168. © . 200
Port 6000
Master-Instance o Select

Correspondence between the servo frequencies of the
Controller and communication periods is as follows:

4 kHz : 250 us

2 kHz : 500 us

1 kHz : 1000 us

In the Master page, enter the IP
address of the Controller in IP
Address, and click the Select
button to apply the setting.

* Default IP address

Device Editor
Master

General
Unit Name Class-A Magter
Cycle Tirne [us] 1000

Source MAC address

Slaves connected to local system
Mebworic Adaptes O—5- TU P4 ( Intel(R) Ethernet Connection 1217:LM )

“192.168.0.200" is specified in Selt
this example. ey o
* Do not select Slaves T - —
connected to local system as
it is not used.
6 Right-click on Class-A Master
in the Project Explorer, and [ = Ec-Engineer [--]
select Scan EtherCAT Network || fle View  Network  Seffings  Help
from the menu. ¢ Configuration Mode ™| B Diagnosis Mo
Project Explorer m
Master
*.. Scan EtherCAT Network
qp Append Slave l
7 Make sure that the slave is
displayed in the Project = EC-Engineer []
Explorer.
File  View MNetwork Settings Help
i Configuration Mode M Export ENI BcC
Project Explorer

- . Claze-& hactar
~ [ Slave_1001 [R88D-1SNO2L-ECT] (1001} |
- Q01 Module 1 (Safety Process Data)

20



6.4.2. Distributed Clock Setup

1 Setting Distributed Clocks (DC)
for Master

In the Project Explorer, select
Class-A Master to display the
Distributed Clocks tab page.

- EC-frgres (]

||.e View Network  Setunga  Help

Distributed Clocks i

oeess Data Image | vanables | Advanced Options | Slave to Sl

Sieve_l001 [RESD-1SNOTL-ECT] {1001)
Reference Clork
001: Madule 1 (Safety Process Data)
Nome Slave_1001 [REB0-1SNOL-ECT] (1001)
Clock Adjustment

@ Master Shift (EtherCAT Master Time controlled by Reference Ouck)
Bus Shilt (Refersmze Clock comtrofisd by FEharCAT Master Tima]
Options
Continucus Propagation Compsnzaticn
Syne Windaw Montanng
Show G4BiK Srstem Time

* |f the Distributed Clocks tab does not appear, select View

then the Expert Mode check box.

2 Select Master Shift (EtherCAT

Master Time controlled by
Reference Clock).

= EC-Enginesr [--]
File Network  Settings Help
¥y vl Messages bort ENI
Short Info
- Expert Mode I-
- Refresh F3  5MNOD2L-ECT
= EE-ngness (]

||.e View Network  Setunga  Help

R e e Expart ENI

W Diagnosss Mode

D —
b Class-A Master | Master | Process Data Image | Vanables | Advanced Options | Sleve to Save | Distributed Clocks | Meiltiple Tasks

= | Siave_1001 [RESD-1SNOTL-ECT] {1001)
Reference Clork

001: Madule 1 (Safety Process Data)
Nome: Slave_1001 [RAD-1SNOIL-ECT] (1001)

@ Master Shift (EtherCAT Master Time controlled by Reference Cock)

Options
Continucus Propagation Compsnzaticn
Syne Windaw Montanng
Show G4BiK Srstem Time

21



3 Setting Distributed Clock (DC)

for the Slave

In the Project Explorer, select

= EC-Engineer [-]

[t.!n Mitw  Metwork  Setbngs  Help

£ Confiquration Mode I ISRl W Disgnosss Mode

T DITEREy Genera u'ea PO Mapping | Variables | Advanced Optiongl Detributed Clock Rt Co
: ~ [ Slave_1001 [RED-16N02L-ECT] (1001) | |
the target slave to display the O AT T Distrbuted Clock
Dperation Mode DC for synchronization
Distributed Clock tab page. Syne it cyce (us) 1000
Overwrite Mode r
41 Syne Units
7] Sync unit 0
Cycle Time
& Sync Unit Cycle x1 1000 us
User defined 1000
Shift Time (us) 500
4 Selectthe Overwrite Mode
check box and specify Shift = Ee.tnginesr -]
. [t'!“ View  [etwork  Settings  Help
TI m e' £ Confiquration Mode S SRS B Diagricss Mode
- 4 (u:.-..am!-..n-. . General | Moduies | FDO Mapping | Variables | Advanced Options | Distributied Clock | [nit Co
| B Slave_1001 [RBBD-15NO2L-ECT] (1001) G e
001: Module 1 (Safety Process Data)
Dperation Mode DC for synchronization
I Overwrite Mode r I
41 Syne Units
7] Sync unit 0
Cycle Time
& Sync Unit Cycle x1 1000 us
I Shift Time (us) 500 I

Correspondence between the servo frequencies of the
Controller and the Shift Time values is as follows:

4 kHz : 125 us

2 kHz : 250 us

1 kHz : 500 us

22



6.4.3. PDO Map Settings

PDO entries without axis settings are subjected to PDO communications as
indefinite values. For this reason, unexpected operations of the motion control

devices may occur, resulting in a personal injury to the user.
Only objects to be configured in Section 6.5.3. Motor Setup must be mapped to
PDO entries.

1 In the Project Explorer, select
the target slave to display the
PDO Mapping tab page.

2 Setting PDO mapping (Inputs)

Inputs
Make sure that the 258th v 1st transmit PDO Mapping (exciuded by Ox1E  Ox1AD00
transmit PDO Mapping Statusword
0x1BO01 check box is selected Position actual vall | 0x6064:00
in the Inputs field. A
v |J]| 238th transmit PDO Mapping 1801

Clear the 273th transmit PDO
Mapping Ox1B10 check box if it 1aputs

iS SeleCted in the |npUtS f|e|d I v Module 1 {Safety Process Data) 273th transmit PDC DXLBIDI’
— e T BIC Lengtn
FSoE Slave Comman | 0xE600:01 8
STO Active 0x6640:00 1
1
1
1
1
1
1
Error 0x6632:00 1
1 =

23



3 Setting PDO mapping (Outputs)

Make sure that the 258th
transmit PDO Mapping
0x1701 check box is selected in
the Outputs field.

Clear the 273th transmit PDO
Mapping 0x1710 check box if it
is selected in the Outputs field.

Outputs
v 1st receive PDO Mapping (excluded by 0x170 0x1600 —_|
Name Index Bit Length
Controlword OxE040:00 16
Target position OxE07AD0 32 3
Touch probe funct OxB088:00 16 .
v [Vl 258th receive PDO Mapping oxa7op L
Tame Thoex B Lengtn
Controlword OwE040:00 16
Target position OxE07AD 32
Touch probe funct  Qx6088:00 16
Physical outputs  OxE0FE:0L 32
Outputs
v [] Module 1 (Safety Process Data).273th receive PDO  0x1710 =
E IW Bit L ength
FSoE Master Comma OxE700:01 8
STO 0x5640:00 1
1
1
1
1
L -
. =
Error Ack Ox6632:00 1
1 -

6.4.4. Creation of an EtherCAT Network Configuration File

1 Click Export ENI on the upper
part of the EC-Engineer page.

= EC-Engineer [--]

File View MNetwork Settings Help

= Export ENI

B, Diagnaosis Mode

<, Configuration Mode

2 Enter a file name, and then
click Save to create an
EtherCAT network configuration
file.

= Export EtherCAT-Network-Information (ENI) File

@TD' . v Computer » Local Disk (C) » tmp

Organize +

= @

Type

MNew folder

Name Date modified

&, Local Disk (C) =
. DeltaTau

. inetpub

o Intel

. OE-Downloade—,

Mo items match your search.

. Omren
. Perflogs

. Program Files

. Program Files {

i tmp - 4 1 3
|
I File name: m I -

Save as type: lEtherCAT-Network-Information (EMI) Files (*xml} V]

“ Hide Folders Save
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I 6.5. Controller Settings

6.5.1. EtherCAT Network Configuration Settings

1 From the Tools menu of Power [ s s i T

PMAC IDE, select System V7 PP (12 81750 em—

o i o EtherCAT. ™

Setup, and after System Setup .

is displayed, select Master[0] EaAT Master oo ACONTS

Deactivated. T T onnl  kboumemdiitiin
2 Click Browse, and load the o 1

EtherCAT network configuration i Ethercae

file created in 6.4.4 Creation of .

an EtherCAT Network EherCAT Masta e ACONTIS

Browse to eni file

Configuration File.

Domenlo EN| e

3 Click Download ENI file to
-
download the EtherCAT network EtherCAT.
Conf|gurat|0n to the Controller. EtherCAT License Status: EtherCAT IO Devices License Only

EtherCAT Master type: ACONTIS

Browse to eni file

Browse | | (L Download EMifite |

6.5.2. EtherCAT Communications Check

Take the following steps to ensure that EtherCAT communications are available.

1 From the Terminal pane, run the
ECAT[0].Enable=1 command to
start EtherCAT communications.

Terminal: Online[192.168.0.200:55H]

ECAT[0].Enable=1

2 In the Terminal or Watch pane, Watch: Online[192.168.0.200:55H] ~ 1 X
make sure that the Send g;mand Command Response
ECAT[O].Enable value turns to 1. Sys.SevoCount 21795740

Sys.ServoPeriod 1
*The OP mode is entered and [EcaTiolEnable 1|
EtherCAT communications are
established.

m

25



3 After making sure that correct Watch: Online[192.168.0.200:55H] » 0 X
. . . On -
communications are available, S| Py | B Bespoess

run the ECAT[0].Enable=0
command from the Terminal
pane to stop EtherCAT
communications.

] Sys.ServaCount 21516894
| Sys.ServoPeriod 1
[ ECATI0L.Enable 0

[ I -

m

Terminal: Online[192.168.0.200:S5H] « 0 X

ECAT[0].Enable=0

4 In the Terminal or Watch pane,
make sure that the
ECAT[0].Enable value turns to O.

[ Sys.ServoCount 21572691
[ Sys. ServoPeriod 1

] ECAT[0].Enable 0

Watch: Online[192.168.0.200:55H] - 0 X
Send O" C d R -
en Demand omman eSpOnNse

m
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6.5.

3. Motor Setup

Configure the motor settings for the Controller.

1

From the Tools menu of Power
PMAC IDE, select System
Setup to display System Setup.

4 Power PMAC Suite (Administrator)

En R RN~ W~ N TEENF:

File Edit View Project Build Debu Ita Tau

{ @4 | Cam Sculptor

Window Help

B Terminal =5 Position JZf watch Bl StEtLI System Setup

Adding motor #1

Click Add motor in Motors of
the tree, and enter 1 for the
motor number.

‘. PowerPMAC System Setup : Online[

File  Database

Sr-4% PowerPMAG (192.168.0.200)
T .

é # Motors
4k Add Motar

=S #_ 1

1. &mplitier Information
@5 2. Motor Information
ooy 3 Command/Feedback

ool & Hardware Interface
B 5. Interactive Feedback
\@ b Safety

b 1. Test and Gommissior

Setting motor Amplifier

Select Motors — 1 — 1.Amplifier
Information of the tree.

Specify the settings as shown
on the right.

Click the Accept button to apply
the settings.

Manufacturer  [OMRON Coporation (ECAT:131)

Part Number | #0000004C

B 1.Amplifier Manufacturer
Vendor 1D
Product I
Vendor Descrption
Product Description
2 Supported Control Mode
Cychc Sync Pasttion control
Cyclc Sync Velocky control
Cychic Sync Torgue control
Profile Posttion Control
Profie Velocity Control
Profie Torque Control
Velocty Mode Control
Interpolated Postion Cortrol
B 3.Supported Signal Type
Analog Command
PWM Command
Vendor ID
Vendor ID of BtherCAT product

[o]

Manufacturer

OMRON Corporation
Slave_002 [R88D-15NO2L-ECT]

True
True
True
True
True
True
False
True

False
False

Select OMRON Corporation.

Part Number
Select #x000000AC.

4.ECAT Slave Settings

Enter a slave number into Slave Number.

B 4 EGAT Slave Settings
Slave Mumber
Mo Of Axes
iz Tndesx

I
1

The slave number can be confirmed in the System Setup

page.

P Dumsbana

g v S

v P tMAC 00 309 60
P rwiees Dmpies

Lrrmae 1o o bie

EtherCAT. ~

ExharCAY Licorse S2aten £

EPah? baper yow MONTS
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4 Select Motors — 1 —

3.Command/Feedback B 1 Amplifier Gontrol/Signal
Control Type Gyclic Position
. Signal Type EtherGAT
Information. B 2 Feedback Type
Prinary Feedoack EtherCAT
Dual Feedback False

Specify the settings as shown
on the right.
Click the Accept button to apply  cevermme

Select the type of contral that amplifier/drive connected to this channel supports. If the amplifier supports more than one made,

make sure the selection here matches the settines an the amplifier/drive.

Control Type
Select Cyclic Position.

Primary Feedback
Select ECAT.
5 Select Motors - 1 - 4. Hardware B 1 Al Cotr/ Sl

Interface. T2 Aol baerace
Command Signal Channel Slave_002 [R88D-15N02L-ECT] (0:0) ($6071) - (Slave_0_607
Ampifier Enable Signal Output Channel Slave_002 [R88D-15N02L-ECT] (0:0) ($6040) - (Slave_0_604
Ampifier Faul Signal Input Channel Slave_002 [R88D-15N02L-ECT] (0:0) ($6041) - (Slave_0_604
B 3.Feedback Interface

Specify the settings as shown e R
on the right. @
Click the Accept button to apply
the settings. Command Signal Channel
Select #x607A(Target Position), and specify the motor
control indication value for Target Position.
Amplifier Enable Signal Output Channel
Select #x6040(Controlword), and specify Controlword
for the motor output.
Amplifier Fault Signal Input Channel
Select #x6041(Statusword), and specify Statusword for
the motor input.
Primary Feedback Channel
Select #x6064(Position actual value), and specify
Position actual value for the motor control feedback.

6.5.4. EtherCAT Variables Settings

1 In the System Setup page, PowerPMAC System Setup : Online[192.168.0.200:5SH]
right-click on File Database
Master[0].Deactivated to -4 PowerPMAC (192.168.0.201

display the pop-up menu, and
select Export EtherCAT
Variables.

i —.
EtherCAT.

i [
rt EtherCAT Variables ———
e T CICETTS e OIS 1_t|18rCAT |Q Device

EtherCAT Master type: ACONTIS
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2 Enter a name for the EtherCAT
variable definition file for user
programs into the root of the
project folder.

' Favorites iz
B Deskiop ! Bin
i Downloads € Language

%] Recent Places | Configuration
Documentation
4 Libraries
% Documents
& Music
i) Pictures

BE Videos

Log
PMAC Script Language

i

1% Computer
&, Local Disk (1)

Date modified

Type

File folder
File folder
File folder
File folder
File folder

File folder

B o)
© Save As =]
@_Ov| « My Documents b PowerPmacSuite b PowerPmac2 » PowerPmac2 b - [ 43 || search PowerPmacz )

Organize ~  New folder = @

File name: | ECAT Variabled

Save as type: | ppmac header files (*.pmh)

5

= Hide Folders

The created EtherCAT variable
definition file is added to under
Global Includes of PMAC
Script Language in Solution
Explorer.

ecat_valiables. pmb

efunch io

watlualvalug ECATL

= Selubion ‘uPowerPmss_GS_Positen_1R
2 uPewerPmac_GS_Position_1kH

3 € Language

6.5.5. Creation of Operation Check Programs
Create programs to be used to check operations.
A specific language is used for the operation check programs. Refer to Power PMAC User’s
Manual and Power PMAC Software Reference Manual for details.

1 Creating the Motion program

In the Solution Explorer pane,
open Project name — PMAC
Script Language — Motion
Programs — progl.pmc.

sdew  Help

- | &
=8 % Foloweng

T 2= 5 Ml
Tivece Gkt

wal i Poutian [ istch

W s
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2 In the programming area of the oL
progl.pmc tab page, write a #1-’>8388608X;
program as shown on the right.
OPEN PROG 1
This example program rotates a INC;
. . . TA800;
motor in the normal direction, TS300-
stops the rotation, then repeats LINEAR;
rotation in the reverse direction }Nh'le 1<2)
and stops. TA800;
TS300;
TM3000;
X10;
DWELL2000;
X-10;
DWELL2000;
}
CLOSE

3 Creating the PLC program . . ==

dow  Help
g = Ay CPU = | 5§ 1a00 = | & = % - I Terminal
orer - Soktion

Poition: Gnlin. « 3 ¥ | |Yelockty Online. » 3 3 || Following Eron.. » 3 X | | Soluion Exply - 3 X

In the Solution Explorer pane,
open Project name — PMAC
Script Language — PLC

Programs —plcl.plc. pyecatclp” catsctivatel.cly | 2151280k | 25182 gmh T x

PR Sustom_gaestpl
] pp Sasbleta
8] pping_disableixt
5] pp_ing_startup.ix

7| pposnecty

- Docunentation
- Loy
5 PMAC Script Lengusge
L Globed Inchades
2015108 prby
okl definmiona.pmdh
i Kinematic Routines
& [ Likearies
v 23 Mation Programs

Brrprrties . T
™ ||| ecascthvatedl.oly Fie Properties
il




4 In the programming area of the
plcl.plc tab page, write a
program as shown on the right.

This example program turns a
servo ON, starts user program 1
for the motor, then exits periodic
execution of the PLC user
program.

open plc 1
while(sys.ecatMasterReady==0){};
ECAT[0].Enable=1;

P1000=Sys.Time+1;
while(P1000>Sys.Time){};

cmd"&lenable";

P1000=Sys.Time+5;
while(P1000>Sys.Time){};

cmd"&1b1r";
disable plc 1;

close

5 Setting the start of the user
program

In the Solution Explorer pane,
open Project name —
Configuration —
pp_disable.txt.

g = AnyCRU = | [ L0 e B T L Termina
Dattian: On 3 % (Webestye Onlng, = 3 X | Fellewngbree . = 0 X |Soltion Eoplentr - Sohation = = 3 X

= Inchude
0L 3038 h
PRprogh
3 Libwrwries
& [ Resltene Boutiees
2 Configuration

= ecatactewielichy

pp.diable.txt| myecatclgl edstactvitel.clg | 200500285 | =

P 1 all the morozs [This opriorl
¥k it e TR cpaim et ety

E"R { f Rl

disable ple 0..31 fiDisable all Script PLC#

clear all buffers

nable ple 1 =
5] pping_startup b
pesarvecly
B pp starhup et
& 3 Dorvmentstion

pp_custom_wve.clg

Propertes - 3 X
pp_disable twt File Properties

o Lk

6 In the programming area of the
pp_disable.txt tab page, add the
program shown on the right to
the last line.

The pp_disable.txt program is
automatically executed when
the Controller starts.

This example program runs the
PLC1 script.

enable plc 1;
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7 Setting motor control

ston [ ek ] Set N fog Bikben E
= 1 W Tok#ien Explerer  Sabtizn ' + 3 X

parameters - 2 =
C AL = G e e B
Vgl ot rat{191 DG D200S5_ = 3 W | Waleming Eree Ordina{l1 )

In the Solution Explorer pane,
open Project name — PMAC
Script Language — Global
Includes — global
definitions.pmh.

F S——
progl pe
3 " Byreawarr

g Inthe programming area of the | Motor[1].FatalFeLimit=0;

global definitions.pmh tab page, | Motor[1].AbortTa=-0.1;
Motor[1].AbortTs= 0;

write the set values to be set Motor[1].MaxSpeed= 5000;
automatically upon power-on. Motor[1].JogTa= -0.1;
Motor[1].JogTs= -1;
Motor[1].JogSpeed= 1000;
Example settings are shown on | Motor[1].HomeVel= 1000;

the right. Coord[1].Tm=100;
Coord[1].FeedTime=60000;
Coord[1].MaxFeedRate=5000;
Coord[1].Td=-0.1;
Coord[1].Ta=-0.1;
Coord[1].Ts=-1;




6.5.6. Project Data Transfer and Operation Check
Transfer the created project data to the Controller.
When a project is transferred, the program starts automatically and the motor starts rotating.

/A WARNING

When the user program and “configuration and setting” data are transferred from
Power PMAC IDE, devices or the machine may perform unexpected operations.
Therefore, before you transfer project data, ensure the destination slave is

operating safely.

Transferring project data restarts the Controller and interrupts communications

with slaves. The time that communications are interrupted depends on the
EtherCAT network configuration.
Before you transfer project data, make sure that the slave settings will not

adversely affect the devices.

The procedure provided in this section checks the operations of the motion
control devices, which may perform unexpected operations.

Take adequate safety measures before starting the checking process described

in this section. Do not start the checking process unless safety is ensured.

When performing the operation check, implement all the steps described in this
section in order to put the output into a safe state.

1 In the Terminal or Watch pane, make sure 7 5o, puac sute (dministraton
that the ECAT[O]EnabIe value |S 0 File Edit View Project Build Debug Tools DetaTau V
- o |
k : =0 & >
If the value is 1, run the @ Terminal 4 Position [Z] Watch [§J Status @i Jog Ribbon | 4> ¢

Watch: Online[192.168.0.200:55H] 3 x

ECAT[0].Enable=0 command from the
Terminal pane to stop EtherCAT
communications. L

Command Response

[ECATIO} Enable 0

#1- Make sure that ECAT[0].Enable=0

Terminal: Online[192 168.0.200:55H]
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2 DOWI’]loading a prOjeCt Solution Explorer - Powe... » 1 X

=)

Right-click the project name in the [ Selution 'PowerPmac_ECC201+5
Solution Explorer pane on the upper right - B C Language | Buld
of the IDE screen, and select Build and [ [ Background F Clean
. +-- [ CPLCs
Download All Programs to run the build 5 B3 Include Debug y
and download. - [ Libraries Build and Download All Programs
. @ [ Realtime Rot

; Download All Programs
#- [ Configuration

+
+ [J Documentation

+ £ Leg Add Macro Project
0

Map PMAC Variables
#- [ PMAC Script Lan | cut
X | Remove

Unload Project

< LLI] Properties

‘=
Properties ~I'X ] r

Make sure that there are no errors in the
Output tab page.

* |f the transfer fails, check details of the
error in the Output tab page.

If the error is a program error, you must
review the program.

If the error is related to EtherCAT settings,
return to System Setup and check
whether there are any incorrect settings.

The program starts running when it has Terminal: Online[192.168.0.200:55H] ~ 1 X
been downloaded successfully.

Make sure that EtherCAT communications
are in the OP state, and that the motor
rotates.

|enab|e plc1

* |f the motor does not rotate, check that
the ECATJ[0].Enable value is 1 in the
Terminal or Watch pane.

If the value is 0, run the following
command from the Terminal pane.
enable plc 1

After you have confirmed an appropriate Terminal: Online[192.168.0.200:55H] ~ 0 X
operation, save the project to the Save Complete
Controller.

Run the save command from the Terminal

pane.

* The transferred project is not yet saved
on the Controller at this stage.

If you turn OFF the power to the Controller,
the transferred project will be discarded.
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7. Appendix Saving and Loading a Project

The following describes the procedures to save a Power PMAC IDE project on the computer, and to
reuse it.

I 7.1. Saving a Project

1 Creating a Configuration File ‘. B pp_prajh
- [ Libraries

[ [ Realtime Routines
Create a Configuration File to save [EBNER] Confiouratigs

] tad Add 4
parameters you have changed in System - o) B—

= roperues
Setup to the project. 1 3

- =] pp_dis Upload Config Files

Download Config Files
Right-click Configuration in the Solution

Explorer pane, and select Generate '
[ [ Documentation
Configuration File. M P e

A Configuration File is added to
Configuration.

Generate Configuration File

2 Right-click on the Configuration File, and & Configuration
from the menu, select Check To - PRI

Download Config File to include itin files
to be downloaded.

[
m

[

Open With...
View Code

|:||| m |:||| |'
[i]

Exclude From Project

>( Delete

Rename

2 L[

]
4

Check To Download Config File

Prope
.| iz | Properties
3 Saving a Project 4 Power PMAC Suite
| File 'Edit View
In the File menu, run Save All to save the R
. Open
project on the computer.

Add
Close
&1 | Close Solution
Upload Projec!
| | save uPowerP

Save uPowerP

I igl Save All I
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I 7.2. Loading and Downloading a Project

1 Start Power PMAC IDE, and
connect to the Controller.
2 Inthe Terminal pane, type the Terminal: Online[192.168.0.200:SSH] + 1 X
$$$*** command to reset the
Controller settings to factory
default.
SSSR%R
3 In the F||e menu, CI|Ck Open - Power PMAC Suite (Administrator)
Projectlsolution tO |0ad the Edit View Tools Delta Tau Window Help
. tth t d New > t - - |Debt.g v|kr,- CPU -|| [
prOJeC a you saved. Open P |l 51 Project/Solution... Ctrl+Shift+0 -
Close & | Fle... I : Velocity:
Response
7 horse
tems As A
Ctrl+Shift+S 5
|:| +P
Recent Files 4
Recent Projects 4
Exit
4 Down|0ading an ENI file PowerPMAC System Setup ; Onaned 192.166.0,200:55H] EEpT—~==
File Database
O s Dl P
o EtherCAT. ™
From the Tools menu of Power R AT Uswias Siatos, ErcAs 10 Doces
PMAC IDE, select System EercAT Mastryos: ACONTS
. Browse to eni file rowse nlcad | e
Setup to display System Setup. : e
Click Browse, and load the ENI —
EtherCAT.

configuration file that you
created in 6.4.4 Creation of an
EtherCAT Network Configuration
File.

EtherCAT License Status: EtherCAT IO Devices License Only
EtherCAT Master type: ACONTIS

Browse to eni file

| Download ENI file |

Click Download ENI file to
download the EtherCAT network
configuration to the Controller.

—
EtherCAT.

EtherCAT License Status: EtherCAT IO Devices License Only

EtherCAT Master type: ACONTIS

B{m

Browse to eni file
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7 Right-click Configuration in the  Selufion Sxplorer=Selut.. =X
Solution Explorer pane, and S —
) ] = 5 Include -
select Download Config Files [ ] 20160204.h
to download the file to the | pp_proj.n
----- [ Libraries
Controller. +- [ Realtime Routines
=Rl =] Configuration )
----- | | ecatactiva Add »
- | | myecat.cf, !
_____ [ pp_custon| = Properties
..... [ pp_custon Upload Config Files
""" =] pp_disable Download Config Files
""" =l pp_inc_dis Generate Configuration File
----- =] pp_inc_sta.
----- | pp_save.cfg

J

----- =] pp_startup.txt L

8 Right-click the project name in Solution Explorer - Powe... v I X

the Solution Explorer pane, and =
. [54 Solution 'PowerPmac_ECC201+5
select Build and Download All M PowerPmac_ECC201+Safe
Programs to run the build and 75 Clanguage | [ Build
: cl
download. ="
Debug 4
- [J Libraries Build and Download All Programs
When the download process is - @ [ Realtime Rof Covmbod Al Tiagans
+- [ Configuration .
complete, make sure that there 4+ 2 Documentation Map PMAC Variables
are no errors in the Output tab - [ Log Loz i
+- [ PMAC Script Lan & | cut
page.
% | Remove
Unlead Project
1 LLI == | Properties
Properties >~ I'X l r
O Stopping a program Terminal: Online[192.168.0.200:S5H] ~ 0 X
If a program is running, execute I
the following command from the
i |disable ple 1
Terminal pane to stop the
program.
disable plc 1 Terminal: Online[192.168.0.200:55H] ~ 1 X

ECAT[0].Enable=0

||ECAT[D].EnabIe=D
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10 Saving the downloaded settings

and programs

After the download process is
complete and you make sure
that there are no errors in the
Output tab page, run the save
command from the Terminal
pane.

* The save command stores the
downloaded project in the
Controller. This operation saves
the settings to be executed
automatically when the power to
the Controller is turned on.

Terminal: Online[192.168.0.200:55H]

Save Complete

}SEVE

11

Restarting after download

Run the following command from
the Terminal pane to restart the
Controller with the downloaded
project.

$$$

Terminal: Online[192.168.0.200:55H]

~ 0 X

usss
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8. Appendix Using Safety Function

To use the STO function in EtherCAT communications, you need to configure the settings for

the EtherCAT master and Safety CPU Unit.

I 8.1. Device Configuration

The following shows an example of hardware components connected to the safety controller.

Model CK3E-OOOOO Model NX-ECC203
Model NY510-A000 o

Model NX-SL3500 Model NX-ID3417
Model NX-SID800 Model NX-OD3256

EtherCAT communications Model NX-SOD400
Model R88D-1SNO2L-ECT

I 8.2. Workflow

8.3 EtherCAT Coupler Unit Settings Prepare to set the EtherCAT Coupler Unit.

v
8.3.1 Creation of a New Project
v

8.3.2 Network Configuration
Settings

v

8.3.3 /0 Map Settings
v

8.3.4 Safety I/O Function Settings
v

8.3.5 Creation of Safety Programs
v

8.3.6 Transfer via Connection to the

Communications Coupler Unit
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v

8.3.7 Output of Couple 1/10
Allocations

v

8.4 Preparation for the Controller
Setup

v

8.5 Installation of ESI Files

v

8.6 EtherCAT Communications Setup

v

8.6.1 Communications Setup for the
EtherCAT Master

\4

8.6.2 Synchronous
Communications Setup

\4

8.6.3 Safety Controller Variable
Settings

v

8.6.4 PDO Map Settings

v

8.6.5 Coupler I/O and Variable
Allocations

\4

8.6.6 Creation of ENI Files and
Download to the Controller

v

8.7 Controller Settings

40

Prepare the Controller settings.

Install the ESI file for slaves into Acontis EC-Engineer.

Set up EtherCAT communications.

Set up the Controller.



I 8.3. EtherCAT Coupler Unit Settings

Configure the slave terminal settings for the EtherCAT Coupler Unit.
Prepare a computer with Sysmac Studio installed.

Windows computer
Sysmac Studio Model NX-ECC203

Model NX-SL3500 Model NX-ID3417
Model NX-SID800 Model NX-OD3256
Model NX-SOD400

@ Additional Information
For the setting procedures for the EtherCAT Coupler Unit and Safety CPU Unit, also refer to
Programmable Multi-Axis Controller Startup Guide for EtherCAT® Communication Coupler
Safety Controllers and 1/0O Units.

8.3.1. Creation of a New Project

1 Connect the coupler to the
computer using a USB cable.

2 Turn on the power to the
coupler and safety controller.

3 Start the Sysmac Studio. |_|
* If the dialog for confirming Sysmac Studio

access rights appears upon
start-up, select starting of
Sysmac Studio.
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4 Create a project in the Sysmac

. §7 offline =3 Project Pronerties
Studio. bR P> | Posectvame
Auth
ri Open Project -
Enter Project name and other . Comment

F?‘ﬁ;l Import...

items of information. Select

Type Standard Project

1.10 for Version, then, click =
Create. A Online . “E[i Select Device

Category Controller

6 Connect to Device
Device NISOT

Version 1.10

[ License

Create

8.3.2. Network Configuration Settings

1 Double-click EtherCAT under New Project - new_Controller_0 - Sysmac Studic
Configurations and Setup in
the Multiview Explorer. : LI

Multiview Explorer

~ 1
new_Controller 0 v | l |
b4 Configurations and Setup

2 Select EtherCAT Coupler Unit
NX-ECC203 in the toolbox, and
drag and drop it directly below
the master in the EtherCAT
Configuration Edit tab page.

3 Select R88D-1SNO2L-ECT in
the toolbox, and drag and drop
it directly below NX-ECC203 in
the EtherCAT Configuration
Edit tab page.
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nght-Cth NX-ECC203 in the New Project - new_Controller_0 - Sysmac Studio

Multiview Explorer, and select File Edit View Insert Project Controller Simulation Tools Help
Coupler Connection (USB) Y @ B @
then Online.
new_Controller 0 v ‘ l ‘
After you have confirmed the i

destination of the USB
connection, click the OK button.

" Edit

Unit Operation Settings

] Frogiamming —— |

¥ i POUs

DOUble'CIICk NX'ECC203 In the New Project - new_Controller_0 - Sysmac Studio
Multiview Explorer to open the File Edt View Insert Project Controller Simuition Tools Help
NX-ECC203 edit page.

Multiview Explorer

new_Controller 0 v

Right-click in the NX-ECC203
tab page and select Compare
and Merge with Actual Unit
Configuration from the menu.

b4 Configurations and Setup
¥ @ EtherCAT

+ Show Model/Unit Name

Rt Caial Muamm b B AT RIV it

¥ Compare and Merge with Actual Unit Configuration ‘

¥ i@ POUs Lisplay Production Intormation

Click Apply Actual Unit
Configuration to apply the
actual unit configuration.

mpare and Merge with Acual Unit Configuration

When the setting is complete,
click OK.

a Apply Actisal Uit Eonfiguration
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6 Right-click NX-ECC203 in the
Multiview Explorer, and select
Coupler Connection (USB)
then Offline.

New Project - new_Controller_0 - Sysmac Studio

File Edit View Insert Project Controller Simulation Tools Help

B Node1 : NX-ECC203 (E001) x

Unit O 1

new_Controller_0
b4 Configurations and Setup
W 5B FtherCAT

v

Compare

Start /O Check

| 4 Programming

m Precautions for Correct Use

You can read only the Unit configuration in the Slave Terminal by comparing and merging
with the actual Unit configuration. You cannot read the I/O allocation information, Unit

operation settings, and Unit application data.
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8.3.3. /O Map Settings

1 Configure the PDO mapping
settings for Servo Driver. : i

Select R88D-1SNO2L-ECT, then o
click Edit PDO Map Settings.

2 In the Edlt PDO Map Settlngs 'Edltainoma_p

PDO entries included in 512th transmit PDO Mapping
Process Data Size : Input 264 [bit] / 304 [bit] Index | e |Data typel PDO entry name |
ayTE R Er

page, select output 273th and
. . Output 240 [bit] / 256 [bit] (B2 Sysmac
Input 273th, then click OK. Selection!Input/Output! — - ”\ WFIa[: .

Output 260th receive PDO Mapping -
Output 261th receive PDO Mapping  -—
Output 62th receive PDO Mapping  —

Output

Input 1st transmit PDO Mapping Editat
Input 258th transmit PDO Mapping —
Input 259th transmit PDO Mapping -
Input 260th transmit PDO Mapping —
Input 261th transmit PDO Mapping -—

[jot|@e®00@0|00|00@

Input

oK Cancel Apply

3 In the Mu|t|V|eW Explorer’ Select New Project - new_Controller_0 - Sysmac Studio

e ———

Configurations and Setup,

L/}
then I/O map tab page to open T
the 11O map pane. new_Contraller_0 7posm"|v § EtherCAT Network Configuration e
v - :::czos
W Sysmac Error Status
. . Obsenvation
Right-click on EtherCAT Minor Faul
Partial Fault R
Network Configuration, and : ‘ bttt regamntoncss . T :
. . ni P NX Unit I/O Data Active Status 7~ n
select Create Device Variable 2 v NXSLE00
¥ Safety CPU Status 3
from the menu. oo Gty I8

Program No Fault
Master Connection Status

4 From the controller selection box New Project - new_SafetyCPUO - Sysmac Studio
in the Multiview Explorer, select
the target Safety CPU Unit.

Multiview Explorer

Double-click /0 map to open the E— D

Safety I/O map tab page. JrenContiolecd Jom
h—-:-—-e-—

™ Task Settings

g

v
» i@l POUs
>
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5 RIght-ClICk on Eth erCAT [ New Project - new_SafetyCPUD - Sysmac Studio
Network, and select Create fle Ser vew lneet Projc Conveler Smuston Toes Hel

Device Variable from the menu.

4 G g

Multiview Explorer
new_SafetyCPL v ¥ & FtherCAT Network
EtherCA Master
Nodel/l ¥ ' NX-SID800 Copy
¥ Safety Inputs
Si00 Logical Value
Si01 Logical Value
Si02 Logical Value
5i03 Logical Value
5i04 Logical Value
5i05 Logical Value
5i06 Logical Value
S5i07 Logical Value
¥ Status
Safety Connection Status|
Safety Input Terminal Stalc-

-1
D Position | Port | RW | DataType |  Variable

L4 Configurations and Setup
» mmul ns
L
-
£ Frogramming
» i@ POUs
» I Data
>y

Search

v Expand/Collapse All

8.3.4. Safety I/O Function Settings

1 From the controller selection New Project - new_SafetyCPUO - Sysmac Studio
box in the Multiview Explorer, File Edit View Insert Project Controller Sir
select the target Safety CPU |y @« a @

Unit. Multiview Explorer

L new_SafetyCPUQ v

Double-click Safety Slave Unit
Parameter Settings under
NX-SID800 of Configurations
and Setup.

 Progomming

» i@ POUs

2 Select Output Single-channel
Semi-conductor from the
toolbox, and drag and drop it
on to input terminal Si00.

[ oo Lfunt? | Pox-S10800 (M2 ¢ Bnstanced) g -

Semiconductor Outpst for Singhe Channed

St - £ hOX-SIDH00 42 : nstanced)
Source  OnexOF  OffxOn eciiaine
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3 DOUbIe'CIiCk Safety S|ave Un|t New Project - new_SafetyCPUD - Sysmac Studio
Parameter Settings under )
NX-S0400 of Configurations
and Setup.

L

Multiview Explorer

L new SafetyCPUO v

A Configurations and Setup

4 Select Single Channel
(without test pulse) from the
toolbox, and drag and drop it
on to output terminal So00.

8.3.5. Creation of Safety Programs

1 Registering programs L4 Programming

v i@l POUs
Right-click Programs under ¥ = Programs
Programming — POUs in the L B
Multiview Explorer, and select L & Function Blocks
Add — Programs from the » 2 Data
menu. b B Safety Task
2 Creating programs T

Data Type | Initial Value | Constant | Comment |

Refer to Section 7 Programming
in the Safety Control Unit User’s
Manual to create safety
programs.

SF_CTU | NOT
N2 S5i00_Logical Value co Ql E002_STO

TEST2 —RESET v

TEST3 PV |
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8.3.6. Transfer via Connection to the Communications Coupler Unit

1 From the controller selection box 8 nex rorect -nen_Controlier 0 - sysmac

File Edit Wiew Insert Project Contrc

in the Multiview Explorer, select

a4 G @
a Safety CPU Unit.

new_Controller_0 = | l ‘

]

2 Select Controller, then B communications Setup | =

Communications Setup from
Select a method to connect to the Safety CPU Unit.

the menu. @ Connect via NI/NX-ser PU Unit 'new_Controller_0"

) Connect via Coupler 'Nodel : NX-ECC203 (E001) : Offline’

Select Connect via Coupler in oK Cancel
the Communications Setup
dialog box, then click the OK

button.
3 Select COﬂtl’O”EI’, then Online New Project - new_SafetyCPUD - Sysmac Studio
from the menu. je Controller] Simulation Tools Help
: v @ G Communications Setup... _
The unit is in online connection L cnline SHE

Multiview Explorer

with slave terminals.

4 From the controller selection box
in the Multiview Explorer, select
a controller.

New Project - new_SafetyCPUD - Sysmac Studio

File Edit View Insert Project Controller

1 o
Y @ B @
j* @ G O

| T T
== D

new tyCPUO

¥ 1% Communications

5 In the edit page for slave W g R e U
T T e
terminals, right-click the _ l2 < &
Communications Coupler Unit, ————=
] Contgusion izt ]
then select Transfer the = =
Settings from computer to

Communications Coupler.

Click Configuration '8 Transfer to Coupler | =
information only or Select tha data to transfer and click the Transfer Button.
Configuration information +
Unit operation setting + Unit
application data.

P Configuration information + Unit operation settings + Unit application data

P Configuration information only

Cancel
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8.3.7. Output of Couple I/O Allocations

1 Select Controller, then Offline
from the menu.
2 Double_cllck Eth EI’CAT under B New Project - new_Controller_0 - Sysmac Studio
File Edit View Insert Project Controller Simulation Tools Help

Configurations and Setup in TEEEE
the Multiview Explorer. =

new_Controller_0

Right-click on Master, then
select Export All Coupler’s 1/0
Allocations. ] i

Undo

Import Slave Settings and Insert New Slave:

Clear All Settings.

Display ESI Libra
Output il o

I 8.4. Preparation for the Controller Setup

Perform the procedure provided in 6.2 Preparation for the Controller Setup.

I 8.5. Installation of ESI Files

Perform the procedure provided in 6.3 Installation of ESI Files.

I 8.6. EtherCAT Communications Setup

8.6.1. Communications Setup for the EtherCAT Master

Perform the procedure provided in 6.4.1 Communications Setup for the EtherCAT Master.

8.6.2. Synchronous Communications Setup

Perform the procedure provided in 6.4.2 Distributed Clock Setup.
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8.6.3. Safety Controller Variable Settings

(1) Checking the coupler I/O allocations
Decompress the ZIP file you saved in 8.3.7 Output of Couple 1/O Allocations, open the expanded
“CouplerMemoryMap.xml”, and check the contents.

The following is an example displayed using Internet Explorer.

[Deviece
Name | Name
[E001

index _[SM[offset |[Size Name  lindex |Datatype  J[offset [sSize |
SlotO(NX-ECC203)505th transmit PDO #x1BFS |3 [o.00 16.00 | XX Unit Registration Status 63 |[#x2003:03_JARRAY [0.7] OF BYTEJ0.00 8.0
[N i 10 Data Ackive Statw 635200503 | ARRAY [0.7] OF BYTE]S 0000 |
FloONX ECC308 5126 it PDO Napiog PXIBFF_ ¥ J16® 1% |5 o s _____Jowaworon Josnt___Jisw_Jioo |
BloONX ECCIE Poddng 2do LI O N T — - |
Slot4(NX-ID3417)Input Data Set 1 [miaoc |3 [s00  Joos [oamron [opuBitoo  [#x6060:01 | 500 Joor |
Input Bit 01 =x6060:02_|[BOOL 1801 Joo1
Input Bit 02 £x6060:03_|[BOOL 13.02 01
Input Bit 03 £x6060:04_| 18.03 01
PIORCECCI0S Poddine TP I N I (N = — N =N =
Slot] (NX-SL3500)Input Data Set 1 [exiaco 3 f2000  [20.00 [NogerUnic £x6000:01 |[ARRAY [0..6] OF BYTEJ0.00  |[7.00
Nodel Unit3 #x6000:02 |[ARRAY [0..5] OF BYTE|[27.00  [l6.00
Node2 £x6000:03 |[ARRAY [0..6] OF BYTH[33.00 | 7.00
Slot] (NX-SL3500)lnput Data Set 2 1AL |3 J40.00 2.0 oo J2.00 |
Blot2(NX-SIDE00)npe Data Set 1 [xtaod 3 4200|700 |FSoESlvecMD  [Exe020:01 |USINT [4200  Jroo |
Safety Input 1st Word #x6021:01 |[UINT 300 2.0
FSoE Slave CRC_D #x6020:03 |[UINT 4500 J2.00
FSoE Slave Conn_ID £x6020:02 T 4700 Jl2.00
Slot2(NX-SID&00)Input Data Set 2 #x1A05 |3 [40.00 [3.00 |IWI ool ot Jwoo oo
|Slot3(NX-50D400)Input Data Set 1 #1408 |3 [5200 |5.00 |Fsom Stave CVD Tix6040:01 [TUSINT 5200 100
[Safety Input 1st Byte #x6041:01 |[USINT 53.00  |[L.00
FSoE Slave CRC_0 4x6040:03|[UINT 5400|200
FSoE Slave Conn_ID £x6040:02_|[UINT [s6.00 200
Slot3(NX-SOD400)Input Data Set 2 1A00 |3 [5800 |20 |Sngudinpwisibye  [meoazol UsT  |s00  |Loo | Fxoono1 JUSNT  [5800 Lo |
I Standard Input 2nd Byte #x6042:02 |[USINT 59,00 [[1.00
g R —
SletS(NX-OD3256)Output Data Sct | 51610 2 000 |p.od Output Bit 00 £x7080:01 L 00 0.01
Output Bit 01 #x7080:02 [[BOOL Jfo-01 0.01
Output Bit 02 #x7080:03 |[BOOL Jlo.02 0.01
| | Output Bit 03 £x7080:04 |@ [o03 0.01
!Slmﬂ{\l}( ECC203)PaddingRxPdo #x1TF6 2 N0.04 1.04 _| |-
Slot1 (NX-SL3500)Output Data St | xis00 2 J200 2000 Nogertme  |Ex7ooo01 | mp—m
Nodel Unit3 £x7000:02 |[ARRAY [0..5] OF BYTE|p.00 6.00
Node2 #7000:03 |[ARRAY [0..6) OF BYTE[15.00  [[7.00
Slot] (NX-SL3500 Data Set 2 =x1601 2 |22.00 .00
I_m‘b_,_
Slot2(NX-SIDE00)Output Data Set 1 ex1604 |2 [[22.00 Fxozo0r Just Je2zo0 L
Safety Output 1st Word #x7021:01 JUINT 2300 200
|[FSoE Master CRC_0 #x7020:03 JJUINT 2500 oo
FSoE Master Conn_ID 2x7020:02 |UD> 2700|200
Slot2(NX-SID800)Output Data Set 2 #x1605 2 2900 [3.00 [ Siandard Output 1st Word mw‘ he00 200
|Standard Output 2nd Byte #x7022:02 3100 [Loo
lot3(NX-SODH00)Output Data St 1 [5x1608 |2 3200 600 |FSoE nasie COMD Ex7020:01 ITUSINT B200  [L.00
Safety Output 1st Byte £x7041:01 |[USINT 3300 oo
[FSoE Master CRC_0 Ex7040:03_|[UINT [B400 Jzo0 |
FSoE Master Conn_[D £x7040:02 600  |2.00
e S e == o—. e —
Ounpm 2nd Byte 7042:02
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(2) Setting Input Data

Register the following input data.

- Slot1(NX-SL3500)Input Data Setl
- Slot1(NX-SL3500)Input Data Set2

- R ———
Slot1(NX-SL3500)Input Data Set 1 Ex1A00 (3 (2000 [20.00 [nodel Uniz Ex6000:01 |[ARRAY [0.6) OF BYTE20.00  [7.00
Nodel Unit3 £x6000:02 JJARRAY [0..5] OF BYTE|R7.00  J[6.00
Node2 2x6000:03 |[ARRAY [0..6] OF BYTE|33.00  [[7.00
Slot](NX-SL3500)nput Data Set 2 Hx1A01 3 |[40.00 Safety CPU Status m_ X
il & v — P
|[Safety Input 1st Word #x6021:01_|[UINT l43.00  J2.00
|[FSoE Slave CRC_0 #x6020:03|[UINT [45.00 J200
|[FSoE Slave Conn_ID Ex6020:02 |[UINT 47.00  J2.00
[m(mmmm)mpmmm: FIA0S 134800 3.00 |Smdatd Input Ist Word gx6022:00 JuNT g0 o0 |
Standard Innul 2nd Byie Ex6022:02_JUSINT 5100 JLoo
Slot3(NX-SOD400)Input Data Set 1 Ex1A08 |3 [5200  |6.00 |;FSoE Slave CMD Fxoioo1 usNt  [b2o0 oo
Safety Input 1st Byte Ex6041:01 |[USINT 5300 100
FSoE Slave CRC 0 4x6040:03 |[UINT Jls+.00 200
L FSoE Slave Conn_ID Ex6040:02_|[UINT [s6.00  |[2.00
Slot3(NX-SOD400)Input Data Set 2 Ex1a09 |3 5800 |00 I?W Input 15t Byte Fwoizo1 usNt  [pso0 oo
|[Standard Input 20d Byte [Exs042:02 JUsINT [se.00 .00

1 Select a safety controller in the

. . Help
Project Explorer of EC-Engineer. T
Display the Variables tab page. [ i
3 e ¢ Kame Datatype ' Groupinfo Offset - | Size
W 003: Module 3 (NX-SOD400}
W 003: Module 4 (NX-1D3417)
W 003 Module 5 (NX-0D3256)
|
Edit Variable
fq_.._;si\_r.”_;m View | Topalagy View i
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Setl]
Registering Node2

Click New in the Variables tab
page, and register three
variables shown on the right.

Datatype : USINT
Count: 1

Group: Module 1(NX-SL3500).Input Data Set 1
Datatype : BOOL
Count: 16

Group: Module 1(NX-SL3500).Input Data Set 1
Datatype : UINT
Count: 2

2 [Slot1(NX-SL3500)Input Data = e —
SEtl] Group |I\'1Ddule 1 (MX-SL3500).Input Data Set 1 |
Registering Nodel/Unit2 Datatype [smr |
(NX-SID800) Count | g

Combine O
Click New in the Variables tab oK Cancel
page, and register two variables
shown on the right.
[FSoE Slave CMD [ex6020:01 JfUSINT |
Group: Module 1(NX-SL3500).Input Data Set 1
Datatype: USINT
Count: 1
|Safety Input 1st Word |[sx6021:01 |JUINT
FSoE Slave CRC 0 [ex6020:03 [[UINT
FSoE Slave Conn_ID [#x6020:02 JUINT
Group: Module 1(NX-SL3500).Input Data Set 1
Datatype: UINT
Count: 3
3 [Slot1(NX-SL3500)Input Data [FSE Slave CMD 4x6040:01 |[USINT
Setl] [Safety Input 1st Byte l£x6041:01 |[USINT
Registering Node1/Unit3 Group: Module 1(NX-SL3500).Input Data Set 1
(NX-SOID400) Datatype : USINT
Count: 2

Click New in the Variables tab

page, and register two variables  [FsqE Slave CRC 0 [£x6040:03 |[UINT

shown on the right. |FSoE Slave Conn_ID [£x6040:02 |[UINT
Group: Module 1(NX-SL3500).Input Data Set 1
Datatype : UINT
Count: 2

4 [Slot1(NX-SL3500)Input Data Group: Module 1(NX-SL3500).Input Data Set 1
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5 [Slot1(NX-SL3500)Input Data
Set2]
Registering Safety CPU Status

Click New in the Variables tab
page, and register the variable
shown on the right.

[Safety CPU Status

[[Ex6004:01  JUTNT

Ga.00

Group: Module 1(NX-SL3500).Input Data Set 2
Datatype: UINT
Count: 1

Jlz.00

6 Checking Input Data

Make sure that the settings
(Input) in the Variables tab page
are correct.

MDP Slot Properties | Vanables

Variables
[ e T
Stave_D31.Modute 1 (NX-5L35001input Data Set LVariabe 0 WSINT [Pefauit] IMN: we 0
Shave_DOLModuse 1 (NX-SL35001dnput Dats Set LVariabie 1 UNT [Detsatt] M: 20 20
Shave_001.Modute 1 MNX-5L3500}Input Dets Set Lvariabie 2 UINT [Defait] ILH 30 20 |EB
i Siave_D01Modue 1 [MX-SL3500)Input Dats Set 1 \ariable 3 LENT [Detaait] IN: 280 20
ESJ'.'!_')JI Modute 1 [NX.SL3500)Input Data St Lvarisbie 3 USINT [Cetauit] IM: 70 1D
!m:_on:.mme 1 [NX-5L3500)dnput Data Set L. Variabie 5 USINT  [Defsutt] IN: 280 10
' Stave_DXLMaodule 1 [MX-5L3500)Input Dats Sat Liacisbie & UINT [Detaait] M ®B0 20
= Save 001Modyte 1 (NX-5L3500)Input Data Set LVaratie 7 LNT [Sefauit] IN: 30 20
| Seave_DO1 Mot 1 [NX-SL3500)Input Data Set LVariabie 8 USINT  [Detsut] IN: 330 10
TR

hmm. —
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(3) Setting Output Data

Register the following output data.

- Slot1(NX-SL3500)Output Data Setl
- Slot1(NX-SL3500)Output Data Set2

[[Stot1 (NX-SL3500)Output Data Set 1 #1600 200 2000 INode ) Unit2 £x7000:01 |[ARRAY [0.6] OF BYTE[2.00 7.0
Node 1 Unit3 £x7000:02 |[ARRAY [0..5] OF BYTE|9.00  |6.00
| | [Node2 £x7000:03_||ARRAY [0.6] OF BYTE|[15.00__|7.00
Slot2(NX-SID800)Output Data Set 1 Fxl604 700 /[FSoE Master CMD [x7o2e:01 JusnT 200 |
Safety Qutput 1st Word #x7021:01 |[UINT 23.00 2.00
|[FSoE Master CRC 0 £x7020:03_|[UINT 2500 |2.00
| | |[FSoE Master Conn_ID £x7020:02_|[UINT 2700 |2.00
Slot2(NX-SID800)Output Data Set 2 Fx1605 |2 120.00 1300 Vandard Output st Word Ex7022:01 JUINT  |29.00  |2.00
Standard Output 2nd Byte #x7022:02_|[USINT 100 |[1.00
Slot3(NX-SOD400)Output Data Set 1 1608 |2 [32.00 690 |FsoE Marer oD 708001 ITUSINT 200 100
Safety Output 1st Byte [£x7041:01_|{USINT 300|100
FSoE Master CRC_0 Ex7040:03_]jUINT 100|200
|[FSoE Master Conn_ID 4x7040:02_|JUINT 600 |2.00
Slot3(NX-50D400)Output Data Set 2 Fx1609 2 138.00 200 [Standard Output Ist Byte Ex7042:01 JUSINT ____ |ps.00_ J.0o ]
[Standard Cutput 2nd Byte exT042:02_|[UsSINT |Bo.o0 oo ]

7 Select a safety controller in the
Project Explorer pane of
EC-Engineer.

Display the Variables tab page.

File View Network  Settings  Help

ke

2 3
B 003 Mogule 3 {NX-5C0D200)
B 002 Module 2 (NX-ID3417)
W 005 Module 5 (NX-0D3256)

| MDP Siot Praper]

Variables

Name

Datatype  Groupindo  Offset = | Size

Edit Variable

| Classic View |Flat View | Topology View

[[FSoE Master CMD [Ex7020:01 JUSINT

[Slot1(NX-SL3500)Output Data
Setl]

Registering Nodel1/Unit2
(NX-SID800)

Click New in the Variables tab
page, and register two variables
shown on the right.

Group: Module 1(NX-SL3500).Output Data Set 1

Datatype: USINT

Count: 1

[[Safery Outpur 15t Werd ux7021:01 |[UINT
[FSoE Master CRC_0 Ex7020:03 |[UINT
[FSoE Master Conn_ID |[exT7020:02  J[umNT

Group: Module 1(NX-SL3500).Output Data Set 1

Datatype:
Count: 3

UINT

54



Perform the procedure provided in 6.4.3 PDO Map Settings.

e} [Slot1(NX-SL3500)Output Data  [[FSeE Master CMD [FxT040:01 [[USINT |
Setl] Safety Output 1st Byte #x7041:01 [[USINT |
Registering Node1/Unit3 Group: Module 1(NX-SL3500).Output Data Set 1
(NX-SOID400) Datatype : USINT

Count: 2
Click New in the Variables tab
page, and register two variables  [FseE Master CRC 0 [ex7040:03 J[UINT |
shown on the right. FSoE Master Conn_ID [ex7040.02 [JUINT |
Group: Module 1(NX-SL3500).Output Data Set 1
Datatype : UINT
Count: 2
10 [Slot1(NX-SL3500)Output Data  Group: Module 1(NX-SL3500).Output Data Set 1
Setl] Datatype : USINT
Registering Node2 Count: 1
Click New in the Variables tab Group: Module 1(NX-SL3500).Output Data Set 1
page, and register three Datatype : BOOL
variables shown on the right. Count: 16
Group: Module 1(NX-SL3500).Output Data Set 1
Datatype : UINT
Count: 2
11 [Slotl(NX-SL3500)Output Data
Set?]
* Qutput Data Set2 is not used
and does not need to be set.
12 Checking Output Data
MDD Skt Properie | Verisbits
Variables
Make sure that the settings _ cvatge | Gropinto | Ofse
(Output) in the Variables tab S e S50 O St 3 o1 o w0 2
page are correct, R ST
Save 0L Mo } (M- SL5500,Output ot Set vl 2 W e oun: 58 20
Sive 00L Mo 1 (LSL3550]Output Do Sek Varbie 3 W e o 7030 |
Siave 0L Mot 1 (NI 5435001 Output Db Set Lvariaie & T e ouT 80 10
Save 001 Mok 1 (MI.5L3500] Oukput Do Set i 5 R R
Save 00L Mot 1 (CSL3500LOutout Dt Set LV 6 W e ouT: 11020
8.6.4. PDO Map Settings
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8.6.5. Coupler I/O and Variable Allocations

(1) Checking the coupler I/O allocations
Decompress the ZIP file you saved in 8.3.7 Output of Couple I/O Allocations, open the expanded
“CouplerCopylinfo.xml”, and check the contents.

The following is an example displayed using Internet Explorer.

Original device name||Original slave model ||Original SM ||Original bit offset Destination device name| | Destination slave model ||Destination SM |[Destination bit offset | Bit size
E001 INX-ECC203 3 160 E001 NX-ECC203 2 176 56
E001 INX-ECC203 3 216 E001 NX-ECC203 2 256 48
E001 INX-ECC203 3 264 E002 R88D-1SNO2L-ECT |2 184 56
E001 INX-ECC203 3 336 E001 NX-ECC203 2 16 56
E001 INX-ECC203 3 416 E001 INX-ECC203 12 72 48
E002 [R88D-1SNO2L-ECT |3 208 E001 NX-ECC203 2 120 56

(2) Setting Input Data
Associate the following items:

- Module 1 (NX-SL3500).Input Data Set 1, and Module 2 (NX-SID800).Output Data Set 1
- Module 1 (NX-SL3500).Input Data Set 1, and Module 3 (NX-SOD400).Output Data Set 1

1 Select Class-A Master in the

Project Explorer page of
EC-Engineer.

Display the Slave to Slave tab
page.

Classic Viey

| Flat View

wwork S

File View  Netw felp

Topalogy View

1 T

v I Slave 1001 [NX-ECC203)

Expand Slave 1001
[NX-ECC203] — Module 1
(NX-SL3500).Input Data Set 1
in Inputs.

Expand Slave 1001
[NX-ECC203] — Module 2
(NX-SID800).Output Data Set 1

MedilaAigriPd | 12 Bits]

Module 1 (NX-5L3500).Input Data Set 1 [112 Bits

Variabie 0 [8 Brs]
varabie 1 [16 Bits]

Associate the following items:

FSOE Master CMD [8 Bits]

meREEe e e

Master | Process Data Image | Varisbies | Advanced Options | Slove to Slave | Distributed Clocks | Multple Tasks

Modide 2 (NX-SIDB00). Output Data Set 1 [36 Bits| &

in Outputs.

Select an Inputs item, then

select the corresponding

Outputs item and click >>.

Inputs Outputs

Variable O FSoE Master CMD
Variable 1 Safety Output 1st Word
Variable 2 FSoE Master CRC_0
Variable 3 FSoE Master Conn_ID
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3 Expand Slave_1001 o [Ty (o Ty v ey e
[NX-ECC203] — Module 1 s s
(NX-SL3500).Input Data Set 1 s e ' :
in Inputs. 3l oot |
Expand Slave_1001 i
[NX-ECC203] — Module 3
(NX-SOD400).0Output Data Set  Associate the following items:
1 in Outputs. Inputs Outputs

Variable 4 FSoE Master CMD

Select an Inputs item, then Variable 5 Safety Output 1st Word
select the corresponding Variable 6 FSOE Master CRC_0
Outputs item and click >>. Variable 7 FSOE Master Conn_ID

4 Expand Slave 1001

[NX-ECC203] — Module 1
(NX-SL3500).Input Data Set 1
in Inputs.

Expand Salve_002 — Module 1
(Safety Process Data). 273th
receive PDO Mapping in
Outputs.

Select an Inputs item, then
select the corresponding
Outputs item and click >>.

Slave to Slave

Inputs Outputs
¥

- - Moagule 3 (NX-30D300) Uutput Data Set 2 [1t -
- Module 1 (NX-5L2500)Input Data Set 1 [128 B Sleve 002
- lave.
Variable 0 [8 Bit
i/ ariabie. 018 Bits] 261th receive PDO Mapping [184 Bits

&Variable 1 [16 Bits] ’
Variable 2 [16 Bits] 5

Variable 3 [16 Bits] =
Variable 4 [8 Bits] [
& Variable 5 [8 Bits]

Variable 6 [16 Bits]

Module 1 (Safety Process Data) 273th receive —
| FSof Master Command 8 Bits] |

ariable & [€ Bits]

i . T

Associate the following items:

Inputs Outputs

Variable 8 FSoE Master Command
Variable 9

Variable 10

(3) Setting Output Data

Associate the following items:

- Module 2 (NX-SID800).Input Data Set 1, and Module 1 (NX-SL3500).Output Data Set 1
- Module 3 (NX-SOD800).Input Data Set 1, and Module 1 (NX-SL3500).Output Data Set 1

5

Expand Slave_1001
[NX-ECC203] — Module 2

(NX-SID800).Input Data Set 1 Cresmecos
in Inputs. AT

Expand Slave_1001
[NX-ECC203] — Module 1
(NX-SL3500).0Output Data Set

1 in Outputs. Inputs Outputs
FSoE Master CMD Variable 0
Select an Inputs item, then Safety Output 1st Word Variable 1
select the corresponding FSOE Master CRC_0 Variable 2
Outputs item and click >>. FSOE Master Conn_ID Variable 3

Master | Process Daka Image | Vanables | Advanced Cptions | Slave to Slave | Digtributed Clocks| Mulbiple Tasks

Slave to Skive

wFocE its]
Data Set 2 [24 Bas]

Module 3 (NX-50D400).Input Data Set 1 (48 Bas]

Associate the following items:
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6 Expand Slave 1001

[NX-ECC203] — Module 3
(NX-SOD800).Input Data Set 1
in Inputs.

Expand Slave 1001
[NX-ECC203] — Module 1
(NX-SL3500).0utput Data Set
1 in Outputs.

Select an Inputs item, then
select the corresponding
Outputs item and click >>.

Master | Process Data Image | Variabies | Advanced Options | 5w B0 Siave | Distributed Clocks | Multiple Tasks

Slave to Slave

Enputs Outpise

FS0E Slave CMD [8 Bits]

LSl its]
(FSoE
g FS0E

Associate the following items:

Inputs Outputs

FSoE Master CMD Variable 4
Safety Output 1st Word Variable 5
FSoE Master CRC_0 Variable 6
FSoE Master Conn_ID Variable 7

Expand
Slave_1001[R88D-1SNO2L-EC
T] — Module 1 (Safety Process
Data). 273th receive PDO
Mapping in Inputs.

Expand Module 1
(NX-SL3500).0Output Data Set
1 in Outputs.

Select an Inputs item, then
select the corresponding
Outputs item and click >>.

Master | Process Cista Image | Varsstles | Advanced Cptons | S o Siave | Distributed Dlocks | Multole Tasis,

Slave tn Slava

Inguts

Associate the following items:

Inputs Outputs

FSoE Slave Command Variable 8
Variable 9
Variable 10
Variable 11

8.6.6. Creation of ENI Files and Download to the Controller

Perform the procedure provided in 8.6.6 Creation of ENI Files and Download to the Controller.

I 8.7. Controller Settings

58

Perform the procedure provided in 8.7 Controller Settings.



9. Appendix Troubleshooting

9.1. Factors Causing EtherCAT Communications To Be Unavailable, and
Corrective Actions
Description Factor Corrective Action

The link is not established.

The Ethernet cable is broken or
the specified cable is not being
used.

If the Ethernet cable is broken
or if the specified cable was not
used, replace the cable.

A connector on the Ethernet
cable used for EtherCAT
communications is
disconnected, the contact is
faulty, or parts are faulty.

Reconnect the connector and
make sure it is mated correctly.

A slave within the EtherCAT
network configuration failed.

Replace the slave.

EtherCAT communications do
not start.

ECAT[0].Enable is set to 0.

From the Terminal pane, run the
ECAT[0].Enable=1 command to
start EtherCAT communications.

The EtherCAT network
configuration in the Controller
does not agree with the
physical network configuration.

Review the settings according
to the procedures provided in
6.4 EtherCAT Communications
Setup.

The Ethernet cable is broken at
a slave in the network, or a
connector is disconnected.

Connect the Ethernet cable
correctly.

Some errors have occurred,
and the ECATJO].error is setto a
value other than 0.

Check the ECAT]O].error value.

A synchronization error occurs
at a slave.

The distribution clock is not set
correctly.

A slave in Free-Run Mode is set
to the reference clock.

Review the settings according
to the procedures provided in
6.4.2 Distributed Clock Setup.

The servo task processing time
exceeds the set period.

Review the program or servo
frequency to adjust it, so that
the servo task processing time
does not exceed the period.
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I 9.2. How to Check for Errors

9.2.1. Checking the EtherCAT Status

You can check the EtherCAT status from System Setup of Power PMAC IDE and Diagnosis Mode
of Acontis EC-Engineer.

B System Setup of Power PMAC IDE

You can check the status of the EtherCAT master and slaves in the System Setup page of Power
PMAC IDE.

% PowerPMAC System Setup : Online[192.168.0.200:55H] =& 8]

File  Database

-4 PowerPMAG (192.169.0.200)
¥ Hardware Diagnosis

—
EtherCAT.

EtherCAT License Status: Mo License

EtherCAT Master type: ACONTIS

Browse to .eni file Browse Download ENI file
Slavestolus,
ECAT[®].5laveCount=1 - Mo Statug Error  Description
ECAT[B].TxTime=47
ECAT[®]-RxTime=38 OF |Nn | Slave_1001 [RE3D-KNOIL-ECT]

Ecat[@].Error=No Error

B Diagnosis Mode of Acontis EC-Engineer
You can check the status of the slaves in the Diagnosis Mode page of Acontis EC-Engineetr.

= EC-Engineer [--] == =

File  Wiew MNetwork Settings Help

# Configuration Mode |} 1 Diagnosis Mode

Project Explorer Device Editor
~ @ Class-A Master <connected: General | Variables | ESC Register | EEPROM | Extended Diagnosis | DC Diagnosis | CoE Object-Dict(4][3)

| o Slave_1001 [R88D-KNO1L-ECT]

State Machine

Current State |0p |
Requested State |0p |
Init
Change State Pre-Op Safe-Op
Error State
Current No error
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Select Network then Network Mismatch Analyzer from the menu to verify the network configuration.

= Network Mismatch Analyzer @Elﬂ

List of slaves

Please, compare the configured slaves with the connected slaves. If something is red, you have a
netwaork configuration mismatch!

Name Configured Slave Revision Alias | Network Slave Revision Alias
Slave_002 [R35  R83D-KNO1L-ECT [2]  0x00020001 0 RESD-KNO1L-ECT [2] | 0x00020001 | 1

Slave_003 [RE8 | RB3D-KNO1L-ECT [3] | 0x00020001 | O

Close

9.2.2. Checking the Controller Status

In the Status page of Power PMAC IDE, you can check the status of the motor, coordinate system,

and system.
To display the Status page, click Status on the toolbar.

M Global Status
You can check system errors such as the WDT error.

Status: Online[192 =l
Motor Status] Coordinate Statu MACRO Status ] ECAT Status
Global Status
Description Status Descripticn Status
AbortAll False HWChangeErr False
BufSizeErr False MNoClocks False
ConfigLoadErr False ProjectlLoadErr False
Default False PwrOnFault False
FileConfigErr False WDTFault MNoFault
FlashSizeErr False
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Bl Motor Status

You can check deviation errors, limit errors, and other states of the motor.

| Description

AmpFault

AmpWarn
AuxFault
BIDir
BlockRequest
ClosedLoop
Csolve
DacLimit
DesVelZero
Encloss
FeFatal
FeWarn
GantryHomed
HomeComplete

HomelnProgress

® Motor not activated

Status

False
False
False
Plus

False
False
False
False
False
False
False
False
False
False
False

M Coordinate Status

You can check deviation errors, limit errors and other states of the coordinate system.

Description Status
AmpEna False
AmpFault False
AmpWarn False
AuxFault False
BlockActive False
BlockRequest False
BufferWarn 0
CC3Active False
CCAddedArc False
CCMode Off
CCMoveType Dwell

|| CCOffReq False
|| ClosedLoop False
ContMotion False
Csolve False
DesVelZero False
Encloss False
EndDelayActive False
ErrorStatus MoError
FeedHold Off
FeFatal False
IEWE m False
e

Description
DtFault
InPos
LimitStop
MinusLimit
PhaseFound
PlusLimit
SoftLimit
SoftLimitDir
SoftMinusLimit
SoftPlusLimit
SpindleMotor
TraceCount
TriggerfMove
TriggerMotFound
TriggerSpeedSel

il Global Statusl MACRO Status l ECAT Status l

Description
LinToPviBuf
LookAheadActive
LockfheadChange
LookAheadDir
LookAheadFlush
LookAheadLookBack
LookAheadReCalc
LockAheadStop
LockfheadWrap
MinusLimit
MoveMode
PlusLimit
ProgActive
ProgProceeding
ProgRunning
SegEnabled
SegMove
SegMoveAccel
SegMoveDecel
SegStopReq
SharpCornerStop
SoftMinusLimit
SoftPlusLimit

Status
False
False
False
False
False
False
False
Plus
False
False |
False
0
False
False
MaxSpeed

»

Status
.False
False
False
Forward
False
False
False
False
False
False
LineCircle
False
False
False
False
False
Off
False
False
False
False
False
False -

m
—
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10. Appendix ECAT]Ji] Structure Elements

The Controller uses motion controller technology developed by Delta Tau Data Systems, Inc.,
(hereafter referred to as DT) in the U.S., however, the ECAT]i] structure elements differ from those of

DT controllers. The following table shows the major changes that have been made from DT

controllers.

Element name

Description

Change

ECATI[i].Enable

ECATI[i].LPIO[K]

ECATIi].Slave[j]
ECATIi].Error

ECAT]Ii].LinkUp
ECAT[i].LPDomainOutputState
ECAT[i].LPDomainState
ECAT[i].LPRxTime
ECAT[i].LPTxTime
ECAT[i].MasterStat
ECAT[i].RTDomainOutputState
ECATIi].RTDomainState

Enabling the EtherCAT
network

Elements of low priority
I/0O module

Slave elements

Error code of enabling
EtherCAT network

Status data structure
elements

0: Disable, 1: Enable (2 and 3 are not
supported.)
Not supported

Not supported

$ 9811000C: Invalid network
configuration

$ 9811002E: Disconnected network
connection

Not supported
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11. Revision History

Revision Revised date Revised content
code
A July 1, 2016 First edition
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